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Introduction

In a vertical-cavity surface-emitting laser (VCSEL) the emission of light occurs in the 
normal direction to the layer structure. This is contrary to the emission characteristics of 
the more common edge-emitting laser, where the light propagation is parallel to the layers 
and emission occurs through cleaved facets.

The different growth and emission characteristics of VCSELs, compared to edge-emitting 
lasers, give advantages when it comes to testing the samples during the fabrication steps. 
Tens of thousands of VCSELs can also be processed in parallel on a wafer.

The structure (see Figure 1) consists of a top and a bottom distributed Bragg reflector 
(DBR) structure with alternating high and low refractive index layers. Each layer in those 
DBR stacks is a quarter of a material wavelength thick.

Figure 1: The structure of a vertical-cavity surface-emitting laser (VCSEL). The top and 
bottom distributed Bragg reflectors (DBRs) consists of alternating layers of GaAs (dark color) 
and AlGaAs (light color). The central cavity has one quantum well (QW) and one layer with 
an aluminum oxide annular ring.

The active material, providing the gain, is located in the cavity between the DBRs. It 
usually consists of one or more quantum well (QW) layers. A quantum well layer is a thin 
layer of a thickness of 100 Å or less. The band gap energy of the quantum well layers is 
smaller than the band gap energy of the adjacent layers. This forms a very narrow potential 
well, with a set of discrete energy levels. Since the energy levels depend both on the 
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material compositions and the quantum well layer thickness, the emission wavelength can 
easily be changed by slightly changing the layer thicknesses and/or the material 
compositions.

As the quantum wells are so thin, the gain is very small. Thus, the DBRs must have a very 
high reflectivity — often larger than 99 %. Otherwise, the gain cannot balance the mirror 
losses.

VCSELs are used in many applications, such as for computer mice, laser printers, and in 
communication.

In this model, an eigenfrequency study is used to find the resonance frequency and 
threshold gain for an oxide-confined, GaAs-based, vertical-cavity surface-emitting laser 
(VCSEL). The oxide can provide both electrical and optical confinement. However, in this 
model only the optical properties are studied.

Model Definition

The model is setup in 2D axisymmetry for the structure in Figure 1. The modes searched 
for have a azimuthal dependence of exp(−j ), where  is the angle of rotation around 
the symmetry axis. Modes with this type of azimuthal dependence can be linearly and 
circularly polarized and have non-zero intensity on the symmetry axis.

The simulations are performed in two steps. A regular eigenfrequency analysis is first 
performed, to find good initial values for the subsequent nonlinear eigenfrequency 
analysis.

The resonance frequencies and threshold gain compare well to values presented in Ref. 1. 
This paper collects the results from different computational methods on this benchmark 
problem.

ϕ ϕ
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Results and Discussion

Figure 2 shows the mode field after the initial Eigenfrequency study. The mode is confined 
essentially between the top and the bottom DBRs.

Figure 2: Surface plot of the mode field after the initial Eigenfrequency study. The plot shows 
the norm of the electric field, with the symmetry axis at r = 0.
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The result after the second (nonlinear) eigenfrequency study is shown in Figure 3. Here a 
a height distribution feature was used to make the field distribution a bit clearer. However, 
the field distribution is very similar to the distribution after the first study.

Figure 3: The mode field distribution after the second study.

The resonance wavelength and the threshold gain coefficient are summarized in Table 1 
below. The results agree well with Figures. 2 and 3 in Ref. 1 for oxide position 3.

Reference

1. P. Bienstman et al., “Comparison of optical VCSEL models on the simulation of oxide-
confined devices,” IEEE J. Quantum Electron., vol. 37, no. 12, pp. 1618–1631, 2001.

Application Library path: Wave_Optics_Module/Verification_Examples/
vertical_cavity_surface_emitting_laser

TABLE 1:  RESONANCE WAVELENGTH AND THRESHOLD GAIN FOR OXIDE POSITION 3.

RESONANCE WAVELENGTH THRESHOLD GAIN

980.3 nm 1217 cm-1
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 In the Select Physics tree, select Optics>Wave Optics>Electromagnetic Waves,

Frequency Domain (ewfd).

3 Click Add.

4 Click Add.

5 Click Study.

6 In the Select Study tree, select General Studies>Eigenfrequency.

7 Click Done.

G E O M E T R Y  1

The model geometry is available as a parameterized geometry sequence in a separate 
MPH-file. If you want to build it from scratch, follow the instructions in Appendix: 
Geometry Modeling Instructions. Otherwise load it from file with the following steps.

1 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
vertical_cavity_surface_emitting_laser_geom_sequence.mph.

3 In the Insert Sequence dialog box, click OK.

4 In the Geometry toolbar, click Build All.
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5 Click the Zoom Extents button in the Graphics toolbar.

G L O B A L  D E F I N I T I O N S

The parameters for the geometry was included in the loaded geometry sequence file.

Geometry Parameters
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometry Parameters in the Label text 
field.

General Parameters
Now, add some general parameters, like the intended wavelength, and some parameters 
defining the materials.

1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type General Parameters in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
vertical_cavity_surface_emitting_laser_general_parameters.txt.

Material Parameters
1 In the Home toolbar, click Parameters and choose Add>Parameters.
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2 In the Settings window for Parameters, type Material Parameters in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
vertical_cavity_surface_emitting_laser_material_parameters.txt.

E L E C T R O M A G N E T I C  W A V E S ,  F R E Q U E N C Y  D O M A I N  ( E W F D )

The geometry is cylindrically symmetric. Solve for modes having an exp(-jϕ) dependence, 
where ϕ is the rotation angle around the symmetry axis. With this rotation angle variation, 
the modes can be nonzero on the symmetry axis.

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (ewfd).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the Out-of-

Plane Wave Number section.

3 In the m text field, type 1. This will give you the expected rotation angle variation, 
discussed above.

Scattering Boundary Condition 1
1 In the Physics toolbar, click Boundaries and choose Scattering Boundary Condition.

2 Click the Select Box button in the Graphics toolbar.

3 Select Boundaries 236–349 only. These entities constitute the outer boundary of the 
rotationally symmetric cylinder.

4 In the Settings window for Scattering Boundary Condition, click to expand the 
Scattering Boundary Condition section.

5 From the Scattered wave type list, choose Cylindrical wave.

Impedance Boundary Condition 1
1 In the Physics toolbar, click Boundaries and choose Impedance Boundary Condition.
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2 Select Boundaries 2 and 229 only. These are the top and bottom boundaries.

M A T E R I A L S

Now, define all the materials for the structure. The selections that will be used was defined 
when the geometry was built. Please consult Appendix: Geometry Modeling Instructions 
for the details about defining cumulative selections when building the geometry sequence.

Air Superstrate
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Air Superstrate in the Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Boundary.
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4 Select Boundary 229 only, which is the top boundary.

5 Locate the Material Contents section. In the table, enter the following settings:

GaAs
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type GaAs in the Label text field.

Property Variable Value Unit Property group

Refractive index, real 
part

n_iso ; nii = n_iso, 
nij = 0

n_air 1 Refractive index

Refractive index, 
imaginary part

ki_iso ; kiii = 
ki_iso, kiij = 0

0 1 Refractive index
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
GaAs Layers.

4 Locate the Material Contents section. In the table, enter the following settings:

AlGaAs
1 Right-click GaAs and choose Duplicate.

2 In the Settings window for Material, type AlGaAs in the Label text field.

Property Variable Value Unit Property group

Refractive index, 
real part

n_iso ; nii = n_iso, 
nij = 0

n_GaAs 1 Refractive index

Refractive index, 
imaginary part

ki_iso ; kiii = 
ki_iso, kiij = 0

0 1 Refractive index
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
AlGaAs Layers.

4 Locate the Material Contents section. In the table, enter the following settings:

QW Gain
1 Right-click AlGaAs and choose Duplicate.

2 In the Settings window for Material, type QW Gain in the Label text field.

Property Variable Value Unit Property group

Refractive index, 
real part

n_iso ; nii = 
n_iso, nij = 0

n_AlGaAs 1 Refractive index

Refractive index, 
imaginary part

ki_iso ; kiii = 
ki_iso, kiij = 0

0 1 Refractive index
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
QW Gain Domain.

4 Locate the Material Contents section. In the table, enter the following settings:

A variable named kappa_QW will be added after all materials have been defined.

QW Loss
1 Right-click QW Gain and choose Duplicate.

2 In the Settings window for Material, type QW Loss in the Label text field.

Property Variable Value Unit Property group

Refractive index, 
real part

n_iso ; nii = 
n_iso, nij = 0

n_QW 1 Refractive index

Refractive index, 
imaginary part

ki_iso ; kiii = 
ki_iso, kiij = 0

kappa_QW 1 Refractive index
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
QW Loss Domain.

4 Locate the Material Contents section. In the table, enter the following settings:

AlAs
1 In the Model Builder window, under Component 1 (comp1)>Materials right-click 

AlGaAs (mat3) and choose Duplicate.

2 In the Settings window for Material, type AlAs in the Label text field.

Property Variable Value Unit Property group

Refractive index, 
real part

n_iso ; nii = 
n_iso, nij = 0

n_QW 1 Refractive index

Refractive index, 
imaginary part

ki_iso ; kiii = 
ki_iso, kiij = 0

kappa_QW_lo
ss

1 Refractive index
14 |  T H R E S H O L D  G A I N  C A L C U L A T I O N S  F O R  V E R T I C A L - C A V I T Y  S U R F A C E - E M I T T I N G  



3 Locate the Geometric Entity Selection section. From the Selection list, choose 
AlAs Domain.

4 Locate the Material Contents section. In the table, enter the following settings:

AlOx
1 Right-click AlAs and choose Duplicate.

2 In the Settings window for Material, type AlOx in the Label text field.

Property Variable Value Unit Property group

Refractive index, 
real part

n_iso ; nii = n_iso, 
nij = 0

n_AlAs 1 Refractive index

Refractive index, 
imaginary part

ki_iso ; kiii = 
ki_iso, kiij = 0

0 1 Refractive index
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
AlOx Domain.

4 Locate the Material Contents section. In the table, enter the following settings:

GaAs Substrate
1 In the Model Builder window, under Component 1 (comp1)>Materials right-click 

Air Superstrate (mat1) and choose Duplicate.

2 In the Settings window for Material, type GaAs Substrate in the Label text field.

3 Locate the Geometric Entity Selection section. Click Clear Selection.

Property Variable Value Unit Property group

Refractive index, 
real part

n_iso ; nii = n_iso, 
nij = 0

n_AlOx 1 Refractive index

Refractive index, 
imaginary part

ki_iso ; kiii = 
ki_iso, kiij = 0

0 1 Refractive index
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4 Select Boundary 2 only, which is the bottom boundary.

5 Locate the Material Contents section. In the table, enter the following settings:

D E F I N I T I O N S

Define a variable for the quantum well gain coefficient. This variable will be used by the 
first physics interface and in the first study. In the second study and for the second physics 
interface, the quantum well gain coefficient will be self-consistently solved for.

Variables 1
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

2 In the Settings window for Variables, locate the Variables section.

Property Variable Value Unit Property group

Refractive index, 
real part

n_iso ; nii = n_iso, 
nij = 0

n_GaAs 1 Refractive index

Refractive index, 
imaginary part

ki_iso ; kiii = 
ki_iso, kiij = 0

0 1 Refractive index
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3 In the table, enter the following settings:

M E S H  1

Setting up the mesh sequence is again simplified by using the selections defined as part of 
the geometry sequence.

Free Triangular 1
In the Mesh toolbar, click Free Triangular.

Size
1 In the Model Builder window, click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extra coarse.

GaAs
1 In the Model Builder window, right-click Mesh 1 and choose Size.

2 In the Settings window for Size, type GaAs in the Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Domain.

Name Expression Unit Description

kappa_QW kappa_QW_gain Refractive index, quantum 
well, gain domain, imaginary 
part
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4 From the Selection list, choose GaAs Layers.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section.

7 Select the Maximum element size check box. In the associated text field, type lda0/6/
n_GaAs.

AlGaAs
1 Right-click GaAs and choose Duplicate.

2 In the Settings window for Size, type AlGaAs in the Label text field.
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
AlGaAs Layers.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lda0/6/n_AlGaAs.

QW Gain
1 Right-click AlGaAs and choose Duplicate.

2 In the Settings window for Size, type QW Gain in the Label text field.
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
QW Gain Domain.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lda0/6/n_QW.

QW Loss
1 Right-click QW Gain and choose Duplicate.

2 In the Settings window for Size, type QW Loss in the Label text field.
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
QW Loss Domain.

AlAs
1 Right-click QW Loss and choose Duplicate.

2 In the Settings window for Size, type AlAs in the Label text field.
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
AlAs Domain.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lda0/6/n_AlAs.

AlOx
1 Right-click AlAs and choose Duplicate.

2 In the Settings window for Size, type AlOx in the Label text field.
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
AlOx Domain.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lda0/6/n_AlOx.

Free Triangular 1
1 In the Model Builder window, click Free Triangular 1.

2 Drag and drop below AlOx.

3 In the Settings window for Free Triangular, click Build All.

S T U D Y  1

Step 1: Eigenfrequency
1 In the Model Builder window, under Study 1 click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Desired number of eigenfrequencies check box. In the associated text field, type 
1.

4 In the Search for eigenfrequencies around text field, type f0.

5 Locate the Physics and Variables Selection section. Select the 
Modify model configuration for study step check box.
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6 In the tree, select Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain 2 (ewfd2).

7 Click Disable in Model. If you do not disable the second physics interface, it will not 
be possible to rerun this study once the second physics is fully defined as it will also 
define a variable called kappa_QW.

8 In the Home toolbar, click Compute.

R E S U L T S

Electric Field (ewfd)
1 In the Electric Field (ewfd) toolbar, click Plot.

This shows that the mode is centered between the top and bottom DBRs and that the 
field has a nonzero amplitude on the symmetry axis.

Eigenfrequencies (ewfd)
1 In the Model Builder window, expand the Results>Derived Values node, then click 

Eigenfrequencies (ewfd).

2 In the Settings window for Global Evaluation, locate the Expressions section.
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3 In the table, enter the following settings:

The wavelength is added to the table in addition to the already existing variables for the 
frequency ewfd.freq and the quality factor ewfd.Qfactor.

4 Click Evaluate.

The quality factor is a measure of the loss in the system. A higher quality factor, means 
less loss.

D E F I N I T I O N S

Now define the settings for the second physics interface and the second study.

Start by adding a point integration operator. This operator will be used when normalizing 
the field.

Point Evaluation
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, type Point Evaluation in the Label text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose Point.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 115 in the Selection text field. This corresponds 
to the point where the top boundary crosses the symmetry axis.

Expression Unit Description

ewfd.lambda0 nm Wavelength in free space
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6 Click OK.

7 In the Settings window for Integration, locate the Advanced section.

8 From the Method list, choose Summation over nodes.

E L E C T R O M A G N E T I C  W A V E S ,  F R E Q U E N C Y  D O M A I N  2  ( E W F D 2 )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain 2 (ewfd2).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, click to expand the 
Equation section.

3 From the Equation form list, choose Frequency domain.

4 From the Frequency list, choose User defined. In the f text field, type freq1. A dependent 
variable with this name will be added later.

5 Locate the Out-of-Plane Wave Number section. In the m text field, type 1.

Initial Values 1
When later solving for the frequency and the threshold gain, the field solution will be 
found close to the initial value specified below.

1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain 2 (ewfd2) click Initial Values 1.

2 In the Settings window for Initial Values, locate the Initial Values section.
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3 Specify the E2 vector as

The withsol operator evaluates the provided expression in the second argument, using 
the solution specified in the first argument.

E L E C T R O M A G N E T I C  W A V E S ,  F R E Q U E N C Y  D O M A I N  ( E W F D )

Impedance Boundary Condition 1, Scattering Boundary Condition 1
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves, 

Frequency Domain (ewfd), Ctrl-click to select Scattering Boundary Condition 1 and 
Impedance Boundary Condition 1.

2 Right-click and choose Copy.

E L E C T R O M A G N E T I C  W A V E S ,  F R E Q U E N C Y  D O M A I N  2  ( E W F D 2 )

Scattering Boundary Condition 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain 2 (ewfd2) and choose Paste Multiple Items.

To be able to add Global Equations nodes, you must first enable Equation-Based 

Contributions from the Show More Options dialog.

2 Click the Show More Options button in the Model Builder toolbar.

3 In the Show More Options dialog box, in the tree, select the check box for the node 
Physics>Equation-Based Contributions.

4 In the tree, select the check box for the node Physics>Advanced Physics Options.

5 Click OK.

Now, you are ready to add Global Equations nodes.

Frequency
1 In the Physics toolbar, click Global and choose Global Equations.

2 In the Settings window for Global Equations, type Frequency in the Label text field.

withsol('sol1',ewfd.Er) r

withsol('sol1',ewfd.Ephi) phi

withsol('sol1',ewfd.Ez) z
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3 Locate the Global Equations section. In the table, enter the following settings:

Here, the previously defined point integration operator is used to normalize the real 
part of a field value to a specified value in the point the operator was defined for. The 
withsol operator is again used for evaluating an expression from the first physics using 
a solution from the first study.

4 Click to expand the Discretization section. From the 
Value type when using splitting of complex variables list, choose Real, as the frequency is a 
real quantity.

5 Locate the Units section. Click Select Dependent Variable Quantity.

6 In the Physical Quantity dialog box, type frequency in the text field.

7 Click Filter.

8 In the tree, select General>Frequency (Hz).

9 Click OK.

10 In the Settings window for Global Equations, locate the Units section.

11 Click Select Source Term Quantity.

12 In the Physical Quantity dialog box, type electric in the text field.

13 Click Filter.

14 In the tree, select Electromagnetics>Electric field (V/m).

15 Click OK.

Gain
1 Right-click Frequency and choose Duplicate.

2 In the Settings window for Global Equations, type Gain in the Label text field.

Name f(u,ut,utt,t) (1) Initial value 
(u_0) (1)

Initial value 
(u_t0) (1/s)

Description

freq1 intop1(real(withso
l('sol1',
ewfd.Er)))-
intop1(real(ewfd2.
Er))

withsol('
sol1',
ewfd.freq
)

0 Frequency
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3 Locate the Global Equations section. In the table, enter the following settings:

Here, the imaginary part of the field value in the point defined by the integration 
operator is set to a specified value.

4 Locate the Units section. Click Select Dependent Variable Quantity.

5 In the Physical Quantity dialog box, type dimension in the text field.

6 Click Filter.

7 In the tree, select General>Dimensionless (1).

8 Click OK.

Also the kappa_QW variable will be a real variable.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Empty Study.

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
Electromagnetic Waves, Frequency Domain (ewfd).

5 Click Add Study in the window toolbar.

6 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Stationary
1 In the Study toolbar, click Study Steps and choose Stationary>Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 Select the Modify model configuration for study step check box.

4 In the tree, select Component 1 (comp1)>Definitions>Variables 1.

5 Click Disable, to avoid that the previously defined kappa_QW variable will be used 
in this study.

Name f(u,ut,utt,t) (V/m) Initial value 
(u_0) (Hz)

Initial value 
(u_t0) (Hz/
s)

Description

kappa_QW intop1(imag(withs
ol('sol1',
ewfd.Er)))-
intop1(imag(ewfd2
.Er))

kappa_QW_
gain

0 Refractive 
index, QW, 
imaginary part
30 |  T H R E S H O L D  G A I N  C A L C U L A T I O N S  F O R  V E R T I C A L - C A V I T Y  S U R F A C E - E M I T T I N G  



6 In the tree, select Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (ewfd).

7 Click Disable in Model.

Solution 2 (sol2)
1 In the Study toolbar, click Show Default Solver, to be able to edit the solver 

sequence.

2 In the Model Builder window, expand the Solution 2 (sol2) node, then click 
Compile Equations: Stationary.

3 In the Settings window for Compile Equations, locate the Study and Step section.

4 Select the Split complex variables in real and imaginary parts check box. This will make 
sure that the real variables defined in the Global Equations will be treated correctly when 
solving.

5 In the Study toolbar, click Compute.

R E S U L T S

Height Expression 1
1 In the Model Builder window, expand the Results>Electric Field (ewfd2) node.

2 Right-click Surface 1 and choose Height Expression.

3 Click the Show Legends button in the Graphics toolbar.

4 Click the Zoom Extents button in the Graphics toolbar.
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5 In the Electric Field (ewfd2) toolbar, click Plot.

Using the Height Expression makes the mode field distribution clearer.

Gain Evaluation
1 In the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, type Gain Evaluation in the Label text 
field.

3 Locate the Data section. From the Dataset list, choose Study 2/Solution 2 (sol2).

4 Locate the Expressions section. In the table, enter the following settings:

5 Click Evaluate.

The wavelength and the threshold material gain values agree well with the results in 
Figs. 2 and 3 of Ref. 1 for oxide position 3.

Expression Unit Description

freq1 THz Frequency

c_const/freq1 nm Wavelength

kappa_QW 1 Refractive index, QW, imaginary part

-2*kappa_QW*k0 1/cm Threshold material gain
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Appendix: Geometry Modeling Instructions

The following instructions will build the VCSEL geometry and define some useful 
selections.

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 Click Done.

G L O B A L  D E F I N I T I O N S

Geometry Parameters
Start by adding some parameters defining the geometry.

1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometry Parameters in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
vertical_cavity_surface_emitting_laser_geometry_parameters.txt.

D B R  P A I R

Add a part representing a pair of high- and low-index layers. This part will be used when 
building the mirror stacks for the laser.

1 In the Model Builder window, right-click Global Definitions and choose Geometry Parts>

2D Part.

2 In the Settings window for Part, type DBR Pair in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
vertical_cavity_surface_emitting_laser_dbr_pair_parameters.txt.

Bottom Layer
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Bottom Layer in the Label text field.
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3 Locate the Size and Shape section. In the Width text field, type w.

4 In the Height text field, type d1.

5 Locate the Position section. In the x text field, type pos_x.

6 In the y text field, type pos_y.

7 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
check box.

8 From the Color list, choose Color 8.

Top Layer
1 Right-click Bottom Layer and choose Duplicate.

2 In the Settings window for Rectangle, type Top Layer in the Label text field.

3 Locate the Size and Shape section. In the Height text field, type d2.

4 Locate the Position section. In the y text field, type pos_y+d1.

5 Locate the Selections of Resulting Entities section. From the Color list, choose Color 18.

6 In the Geometry toolbar, click Build All.

7 Click the Zoom Extents button in the Graphics toolbar.

G E O M E T R Y  1

Now, use the part to start building the bottom mirror.
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DBR Pair 1 (pi1)
1 In the Geometry toolbar, click Parts and choose DBR Pair.

2 In the Settings window for Part Instance, locate the Input Parameters section.

3 In the table, enter the following settings:

4 Click to expand the Domain Selections section. Click to select row number 1 in the table.

5 Click New Cumulative Selection.

6 In the New Cumulative Selection dialog box, type AlGaAs Layers in the Name text field. 
The cumulative selections will later be used when assigning the materials and when 
building the mesh sequence.

7 Click OK.

8 In the Settings window for Part Instance, locate the Domain Selections section.

9 Click to select row number 2 in the table.

10 Click New Cumulative Selection.

11 In the New Cumulative Selection dialog box, type GaAs Layers in the Name text field.

12 Click OK.

Bottom DBR
1 In the Geometry toolbar, click Transforms and choose Array.

2 In the Settings window for Array, type Bottom DBR in the Label text field.

3 Click in the Graphics window and then press Ctrl+A to select both objects.

4 Locate the Size section. From the Array type list, choose Linear.

5 In the Size text field, type N_bottom_DBR.

6 Locate the Displacement section. In the z text field, type t_DBR_pair.

7 Click Build All Objects.

Name Expression Value Description

d1 t_AlGaAs_DBR 7.963E-8 m Thickness, bottom layer

d2 t_GaAs_DBR 6.949E-8 m Thickness, top layer

w d_outer/2 6E-6 m Width
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8 Click the Zoom Extents button in the Graphics toolbar.

In the following instructions, you will see many Build All Objects instructions followed 
by a Zoom Extents instructions. Performing those steps will help you display your 
progress, when building the VCSEL geometry. However, they are not necessary for 
building a correct geometry.

Top Layer in Bottom DBR
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Top Layer in Bottom DBR in the Label text 
field.

3 Locate the Size and Shape section. In the Width text field, type d_outer/2.

4 In the Height text field, type t_AlGaAs_DBR.

5 Locate the Position section. In the z text field, type N_bottom_DBR*t_DBR_pair.

6 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. From the Contribute to list, choose AlGaAs Layers.

7 Click Build All Objects.
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8 Click the Zoom Extents button in the Graphics toolbar.

Bottom GaAs Layer in Lambda Cavity
1 Right-click Top Layer in Bottom DBR and choose Duplicate.

2 In the Settings window for Rectangle, type Bottom GaAs Layer in Lambda Cavity 
in the Label text field.

3 Locate the Size and Shape section. In the Height text field, type t_GaAs_cavity.

4 Locate the Position section. In the z text field, type t_bottom_DBR.

5 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. From the Contribute to list, choose GaAs Layers.

6 Click Build All Objects.
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7 Click the Zoom Extents button in the Graphics toolbar.

QW Gain Domain in Lambda Cavity
1 Right-click Bottom GaAs Layer in Lambda Cavity and choose Duplicate.

2 In the Settings window for Rectangle, type QW Gain Domain in Lambda Cavity in the 
Label text field.

3 Locate the Size and Shape section. In the Width text field, type d_oxide/2.

4 In the Height text field, type t_QW.

5 Locate the Position section. In the z text field, type t_bottom_DBR+t_GaAs_cavity.

6 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

7 In the New Cumulative Selection dialog box, type QW Gain Domain in the Name text field.

8 Click OK.

9 In the Settings window for Rectangle, click Build All Objects.
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10 Click the Zoom Extents button in the Graphics toolbar.

QW Loss Domain in Lambda Cavity
1 Right-click QW Gain Domain in Lambda Cavity and choose Duplicate.

2 In the Settings window for Rectangle, type QW Loss Domain in Lambda Cavity in the 
Label text field.

3 Locate the Size and Shape section. In the Width text field, type (d_outer-d_oxide)/2.

4 Locate the Position section. In the r text field, type d_oxide/2.

5 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

6 In the New Cumulative Selection dialog box, type QW Loss Domain in the Name text field.

7 Click OK.

8 In the Settings window for Rectangle, click Build All Objects.
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9 Click the Zoom Extents button in the Graphics toolbar.

Top GaAs Layer in Lambda Cavity
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Bottom GaAs Layer in Lambda Cavity (r2) and choose Duplicate.

2 In the Settings window for Rectangle, type Top GaAs Layer in Lambda Cavity in the 
Label text field.

3 Locate the Position section. In the z text field, type t_bottom_DBR+t_GaAs_cavity+
t_QW.

4 Click Build All Objects.
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5 Click the Zoom Extents button in the Graphics toolbar.

A layer with zero thickness cannot be added to the geometry sequence. Thus, enclose 
this layer within an if statement.

If Bottom AlGaAs Layer in Oxide Window is Finite
1 In the Geometry toolbar, click Programming and choose If + End If.

2 In the Settings window for If, type If Bottom AlGaAs Layer in Oxide Window is 
Finite in the Label text field.

3 Locate the If section. In the Condition text field, type 
t_AlGaAs_oxide_window_bottom_layer>0.

Bottom AlGaAs Layer in Oxide Window
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Top Layer in Bottom DBR (r1) and choose Duplicate.

2 In the Settings window for Rectangle, type Bottom AlGaAs Layer in Oxide Window 
in the Label text field.

3 Locate the Size and Shape section. In the Height text field, type 
t_AlGaAs_oxide_window_bottom_layer.

4 Locate the Position section. In the z text field, type t_bottom_DBR+t_cavity.
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End If Bottom AlGaAs Layer in Oxide Window is Finite
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

End If 1 (endif1).

2 In the Settings window for End If, type End If Bottom AlGaAs Layer in Oxide 
Window is Finite in the Label text field.

3 Click Build All Objects.

4 Click the Zoom Extents button in the Graphics toolbar.

AlAs Domain in Oxide Window
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Bottom AlGaAs Layer in Oxide Window (r6) and choose Duplicate.

2 Drag and drop Bottom AlGaAs Layer in Oxide Window 1 (r7) below 
End If Bottom AlGaAs Layer in Oxide Window is Finite (endif1).

3 In the Settings window for Rectangle, type AlAs Domain in Oxide Window in the Label 
text field.

4 Locate the Size and Shape section. In the Width text field, type d_oxide/2.

5 In the Height text field, type t_oxide.

6 Locate the Position section. In the z text field, type t_bottom_DBR+t_cavity+
t_AlGaAs_oxide_window_bottom_layer.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.
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8 In the New Cumulative Selection dialog box, type AlAs Domain in the Name text field.

9 Click OK.

10 In the Settings window for Rectangle, click Build All Objects.

11 Click the Zoom Extents button in the Graphics toolbar.

AlOx Domain in Oxide Window
1 Right-click AlAs Domain in Oxide Window and choose Duplicate.

2 In the Settings window for Rectangle, type AlOx Domain in Oxide Window in the Label 
text field.

3 Locate the Size and Shape section. In the Width text field, type (d_outer-d_oxide)/2.

4 Locate the Position section. In the r text field, type d_oxide/2.

5 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

6 In the New Cumulative Selection dialog box, type AlOx Domain in the Name text field.

7 Click OK.

8 In the Settings window for Rectangle, click Build All Objects.
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9 Click the Zoom Extents button in the Graphics toolbar.

Bottom AlGaAs Layer in Oxide Window (r6), End If Bottom AlGaAs Layer in Oxide 
Window is Finite (endif1), If Bottom AlGaAs Layer in Oxide Window is Finite (if1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1, Ctrl-click to 

select If Bottom AlGaAs Layer in Oxide Window is Finite (if1), 
Bottom AlGaAs Layer in Oxide Window (r6), and 
End If Bottom AlGaAs Layer in Oxide Window is Finite (endif1).

2 Right-click and choose Duplicate.

If Second AlGaAs Layer in Oxide Window is Finite
1 In the Settings window for If, type If Second AlGaAs Layer in Oxide Window is 

Finite in the Label text field.

2 Locate the If section. In the Condition text field, type 
t_AlGaAs_oxide_window_second_layer>0.

Second AlGaAs Layer in Oxide Window
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Bottom AlGaAs Layer in Oxide Window 1 (r9).

2 In the Settings window for Rectangle, type Second AlGaAs Layer in Oxide Window 
in the Label text field.

3 Locate the Size and Shape section. In the Height text field, type 
t_AlGaAs_oxide_window_second_layer.
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4 Locate the Position section. In the z text field, type t_bottom_DBR+t_cavity+
t_AlGaAs_oxide_window_bottom_layer+t_oxide.

End If Second AlGaAs Layer in Oxide Window is Finite
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

End If Bottom AlGaAs Layer in Oxide Window is Finite 1 (endif2).

2 In the Settings window for End If, type End If Second AlGaAs Layer in Oxide 
Window is Finite in the Label text field.

3 Click Build All Objects.

4 Click the Zoom Extents button in the Graphics toolbar.

Top GaAs Layer in Oxide Window
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Bottom GaAs Layer in Lambda Cavity (r2) and choose Duplicate.

2 In the Settings window for Rectangle, type Top GaAs Layer in Oxide Window in the 
Label text field.

3 Locate the Size and Shape section. In the Height text field, type t_GaAs_DBR.

4 Locate the Position section. In the z text field, type t_bottom_DBR+t_cavity+
t_AlGaAs_oxide_window_bottom_layer+t_oxide+

t_AlGaAs_oxide_window_second_layer.

5 Click Build All Objects.
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6 Click the Zoom Extents button in the Graphics toolbar.

DBR Pair 2 (pi2)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

DBR Pair 1 (pi1) and choose Duplicate.

2 In the Settings window for Part Instance, locate the Input Parameters section.

3 In the table, enter the following settings:

Top DBR
1 In the Geometry toolbar, click Transforms and choose Array.

2 In the Settings window for Array, type Top DBR in the Label text field.

3 Select the objects pi2(1) and pi2(2) only.

4 Locate the Size section. From the Array type list, choose Linear.

5 In the Size text field, type N_top_DBR.

6 Locate the Displacement section. In the z text field, type t_DBR_pair.

7 Click Build All Objects.

Name Expression Value Description

pos_y t_bottom_DBR+
t_cavity+
t_oxide_window

4.8312E-6 m Vertical position
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8 Click the Zoom Extents button in the Graphics toolbar.

This completes the setup of the geometry sequence.
47 |  T H R E S H O L D  G A I N  C A L C U L A T I O N S  F O R  V E R T I C A L - C A V I T Y  S U R F A C E - E M I T T I N G



48 |  T H R E S H O L D  G A I N  C A L C U L A T I O N S  F O R  V E R T I C A L - C A V I T Y  S U R F A C E - E M I T T I N G  


	Threshold Gain Calculations for Vertical-Cavity Surface-Emitting Lasers (VCSELs)
	Introduction
	Model Definition
	Results and Discussion
	Reference
	Modeling Instructions
	Appendix: Geometry Modeling Instructions


